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MIPI C-PHY Compliance Test Application — At A Glance
The Keysight U7250A MIPI C-PHY Compliance Test Application allows the testing of all MIPI devices 
with the Keysight Infiniium oscilloscope based on the MIPI Alliance Standard for C-PHY v1.0 
specification. MIPI stands for Mobile Industry Processor Interface. The MIPI alliance is a collaboration 
of mobile industry leader with the objective to define and promote open standards for interfaces to 
mobile application processors.

The MIPI C-PHY Compliance Test Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Provides detailed information for each test that has been run, and lets you specify the thresholds 
at which marginal or critical warnings appear.

• Creates a printable HTML report of the tests that have been run.

Required Equipment and Software

In order to run the MIPI C-PHY Compliance Test Application, you need the following equipment and 
software:

• U7250A MIPI C-PHY Compliance Test Application software.

• The minimum version of Infiniium oscilloscope software (see the U7250A Compliance Test 
Application release notes).

• Differential probe amplifier, with the minimum bandwidth of 5 GHz.

• E2677A differential solder-in probe head, E2675A differential browser probe head, E2678A 
differential socket probe head, and E2669A differential kit which includes E2675A, E2677A, and 
E2678A are recommended.

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Keysight also recommends using a second monitor to view the automated test application.

Below are the required licenses:

• U7250A MIPI C-PHY Compliance Test Application (MCC).

• Serial Data Analysis (SDA).

• InfiniiScan (SWT).

NOTE The tests performed by the MIPI C-PHY Compliance Test Application are intended to provide a 
quick check of the electrical health of the DUT. This testing is not a replacement for an exhaustive 
test validation plan.
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In This Book
This manual describes the tests that are performed by the MIPI C-PHY Compliance Test Application 
in more detail.

• Chapter 1, “Installing the MIPI C-PHY Compliance Test Application” describes how to install and 
license the automated test application software (if it was purchased separately).

• Chapter 2, “Preparing to Take Measurements” describes how to start the MIPI C-PHY Compliance 
Test Application and gives a brief overview of how it is used.

• Chapter 3, “TX Electrical Signaling and Timing Tests” contains an overview on the signaling and 
timing electrical tests for high-speed transmitters and low-power transmitters.

• Chapter 4, “1.2.1 High-Speed Transmitter (HS-TX) Electrical Tests” contains an overview on the 
electrical tests for high-speed transmitters (HS-TX).

• Chapter 5, “1.2.2 Low Power Transmitter (LP-TX) Electrical Tests” describes the electrical tests for 
low-power transmitters (LP-TX).

• Chapter 6, “1.2.3 High-Speed Transmitter (HS-TX) Timing Tests” describes the timing tests for 
high-speed transmitters (HS-TX).

• Chapter 7, “Calibrating the Infiniium Oscilloscope” describes how to calibrate the oscilloscope in 
preparation for running the MIPI C-PHY automated tests.

• Chapter 8, “InfiniiMax Probing” describes the probe amplifier and probe head recommendations for 
MIPI C-PHY conformance testing.

See Also

• The MIPI C-PHY Compliance Test Application’s Online Help, which describes:

• Starting the MIPI C-PHY Compliance Test Application.

• Creating or opening a test project.

• Setting up the MIPI C-PHY test environment.

• Selecting tests.

• Configuring selected tests.

• Defining compliance limits.

• Connecting the oscilloscope to the DUT.

• Running tests.

• Automating the application.

• Viewing test results.

• Viewing/exporting/printing the HTML test report.

• Saving test projects.

• Installing/removing add-ins.

• Controlling the application via a remote PC.

• Using a second monitor.

• The MIPI C-PHY standard specifications are available in C-PHY Physical Layer Conformance Test 
Suite v1.0r10 (23Mar2015).
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1 Installing the MIPI C-PHY 
Compliance Test Application

Installing the Software  /  12
Installing the License Key  /  13

If you purchased the U7250A MIPI C-PHY Compliance Test Application separately, you must install 
the software and license key.
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Installing the Software

1 Make sure you have the minimum version of Infiniium Oscilloscope software (see the U7250A test 
application release notes) by choosing Help>About Infiniium... from the main menu.

2 To obtain the MIPI C-PHY Compliance Test Application, go to Keysight Web site: 
http://www.keysight.com/find/scope-apps-sw/.

3 The link for MIPI C-PHY Compliance Test Application will appear. Double-click the link and follow 
the instructions to download and install the application software.

http://www.keysight.com/find/scope-apps-sw/
http://www.keysight.com/find/scope-apps-sw/
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Installing the MIPI C-PHY Compliance Test Application 1

Installing the License Key

1 Request a license code from Keysight by following the instructions on the Entitlement Certificate.

You will need the Oscilloscope’s “Option ID Number”, which you can find in the Help>About 
Infiniium... dialog box.

2 After you receive your license code from Keysight, choose Util ities>Install Legacy Licenses....

3 In the Install Option License dialog, enter your license code and click Install License.

4 Click OK in the dialog that tells you to restart the Infiniium oscilloscope application software to 
complete the license installation.

5 Click Close to close the Install Option License dialog.

6 Choose File>Exit.

7 Restart the Infiniium oscilloscope application software to complete the license installation.
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2 Preparing to Take 
Measurements

Calibrating the Oscilloscope  /  16
Starting the MIPI C-PHY Compliance Test Application  /  17

Before running the MIPI C-PHY automated tests, you must calibrate the oscilloscope and probe. No 
test fixture is required for this MIPI C-PHY application. After the oscilloscope and probe have been 
calibrated, you are ready to start the MIPI C-PHY Compliance Test Application and perform the 
measurements.
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Calibrating the Oscilloscope

• If you have not already calibrated the oscilloscope and probe, see Chapter 7, “Calibrating the 
Infiniium Oscilloscope.

NOTE If the ambient temperature changes more than 5 degrees Celsius from the calibration temperature, 
internal calibration should be performed again. The delta between the calibration temperature and 
the present operating temperature is shown in the Util ities>Calibration menu.

NOTE If you switch cables between channels or other oscilloscopes, it is necessary to perform cable and 
probe calibration again. Keysight recommends that, once calibration is performed, you label the 
cables with the channel on which they were calibrated.
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Preparing to Take Measurements 2

Starting the MIPI C-PHY Compliance Test Application

1 From the Infiniium Oscilloscope’s main menu, choose Analyze>Automated Test Apps>U7250A MIPI 
C-PHY Test App.

Figure 1 Starting the MIPI C-PHY Compliance Test Application

NOTE If the U7250A MIPI C-PHY Test App does not appear in the Automated Test 
Apps menu, the MIPI C-PHY Compliance Test Application has not been 
installed (see Chapter 1, “Installing the MIPI C-PHY Compliance Test 
Application”).
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Figure 2 The MIPI C-PHY Compliance Test Application’s default window

Figure 1 shows the procedure to launch the MIPI C-PHY Compliance Test Application and Figure 2 
shows the MIPI C-PHY Compliance Test Application default window. The task flow pane, and the 
tabs in the main pane, show the steps you take in running the automated tests:

Tab Description

Set Up Lets you identify and set up the test environment, including information about the device under 
test.

Select Tests Lets you select the tests you want to run. The tests are organized hierarchically so you can select 
all tests in a group. After tests are run, status indicators show which tests have passed, failed, or 
not been run, and there are indicators for the test groups.

Configure Lets you configure test parameters. This information appears in the HTML report.

Connect Shows you how to connect the oscilloscope to the device under test for the tests to be run.

Run Tests Starts the automated tests. If the connections to the device under test need to be changed while 
multiple tests are running, the tests pause, show you how to change the connection, and wait for 
you to confirm that the connections have been changed before continuing.

Automation Lets you construct scripts of commands that drive execution of the application.

Resul ts Contains more detailed information about the tests that have been run. You can change the 
thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.
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Preparing to Take Measurements 2

NOTE The configuration options shown under the Set Up tab of the MIPI C-PHY 
Compliance Test Application main window dictate the availability of various 
tests. You may have to select more than one configuration option to make 
some tests available, else they appear unavailable/disabled. To know more 
about the configurable options under the Set Up tab that must be selected 
for each test, refer to the section, “Test Availability” under the method of 
implementation for each test in this document.
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Online Help Topics

For information on using the MIPI C-PHY Compliance Test Application, see its Online Help (which 
you can access by choosing Help>Contents... from the application’s main menu).

The MIPI C-PHY Compliance Test Application’s Online Help describes:

• Starting the MIPI C-PHY Compliance Test Application.

• Creating or opening a test project.

• Setting up the MIPI C-PHY test environment.

• Selecting tests.

• Configuring selected tests.

• Defining compliance limits.

• Connecting the oscilloscope to the device under test (DUT).

• Running tests.

• Automating the application.

• Viewing test results.

• Viewing/exporting/printing the HTML test report.

• Saving test projects.

• Installing/removing add-ins.

• Controlling the application via a remote PC.

• Using a second monitor.
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3 TX Electrical Signaling and 
Timing Tests

Overview  /  22

The Keysight U7250A MIPI C-PHY Compliance Test Application enables compliance testing of the 
High-Speed Transmitter (HS-TX) and Low-Power Transmitter (LP-TX), in adherence to the MIPI 
C-PHY specifications.
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Overview

The group of tests specified in this Methods of Implementation document pertains to the MIPI C-PHY 
specifications. The tests within these test groups are developed to cater for High-Speed Transmitter 
and Low-Power Transmitter testing.

Figure 3 and Figure 4 show the circuit diagram of a C-PHY Transceiver and the associated C-PHY 
signaling levels, respectively.

Figure 3 Circuit Diagram of a C-PHY Transceiver
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TX Electrical Signaling and Timing Tests 3

Figure 4 C-PHY Signaling Levels

Notice that the signal levels for the Differential High-Speed mode differ from that for the 
single-ended Low-Power mode. The High-Speed signaling levels are below the low level input 
threshold for the Low-Power mode such that the Low Power receiver always detects low on HS 
signals.

The actual maximum bit rate for the High-Speed mode is not specified in the MIPI C-PHY 
specifications. However, the specification document is primarily intended to define a solution for a bit 
range from 80 Mbps to 2.5 Gbps (or above) per Lane. A typical implementation is expected to have a 
bit rate of approximately 500Mbps per Lane.

For the Low-Power mode, the maximum data rate specified in the MIPI C-PHY specifications is 
10Mbps.
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Test Availability in the C-PHY Compliance Test Application

The C-PHY Compliance Test Application consists of some options in the Set Up tab that dictate the 
availability of certain tests. The test settings could be affected by one or more configuration options. 
For such tests, if one of the option is disabled, the test is unavailable. The options in the Set Up tab, as 
shown in Figure 5, which primarily affect the availability of tests are:

1 HS Burst Data — LPEscapeMode

2 LP Escape ONLY

3 Informative Tests

Figure 5 C-PHY Configuration Options in the Set Up tab

To check for the configuration options that impact the availability of each of the tests described in 
this document, refer to the “Test Availability” section for each test.

Broadly, the test groups are categorized as:

1 HS Electrical Tests

2 LP Tests

3 HS Timing Tests
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4 1.2.1 High-Speed Transmitter 
(HS-TX) Electrical Tests

Probing for High-Speed Transmitter Electrical Tests  /  26
Test 1.2.7 HS-TX Differential Voltages (VOD-AB, VOD-BC, VOD-CA)  /  28
Test 1.2.8 HS-TX Differential Voltage Mismatch (∆VOD)  /  31
Test 1.2.9 HS-TX Single-Ended Output High Voltages (VOHHS(VA), VOHHS(VB), VOHHS(VC))  /  32
Test 1.2.10 HS-TX Static Common-Point Voltages (VCPTX)  /  33
Test 1.2.11 HS-TX Static Common-Point Voltage Mismatch (∆VCPTX(HS))  /  35
Test 1.2.12 HS-TX Dynamic Common-Point Variations Between 50-450MHz (∆VCPTX(LF))  /  36
Test 1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (∆VCPTX(HF))  /  38
Test 1.2.14 HS-TX Rise Time (tR)  /  40
Test 1.2.15 HS-TX Fall Time (tF)  /  42
Test 1.2.17 30%-85% Post-EoT Rise Time (TREOT)  /  44
Test 1.2.19 HS Clock Instantaneous UI (UIINST)  /  46
Test 1.2.20 HS Clock Delta UI (∆UI)  /  48

This section provides the Methods of Implementation (MOIs) for the electrical tests for high-speed 
transmitters (HS-TX) using an Keysight Infiniium oscilloscope, InfiniiMax probes, and the MIPI C-PHY 
Compliance Test Application.
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Probing for High-Speed Transmitter Electrical Tests

When performing the HS Electrical tests, the MIPI C-PHY Compliance Test Application will prompt 
you to make the proper connections. The connections for the HS Electrical tests may look similar to 
the following diagram. Refer to the Connect tab in the MIPI C-PHY Compliance Test Application for 
the exact number of probe connections.

Figure 6 Probing for High-Speed Transmitter Electrical Tests

You can identify the channels used for each signal in the Configure tab of the MIPI C-PHY Compliance 
Test Application. (The channels shown in Figure 6 are just examples).

For more information on the probe amplifiers and probe heads, see Chapter 8, “InfiniiMax Probing,” 
starting on page 93.

Test Procedure

1 Start the automated test application as described in “Starting the MIPI C-PHY Compliance Test 
Application" on page 17.

2 In the MIPI C-PHY Compliance Test Application, click the Set Up tab.

3 Select the Data Type and the Device Information.

4 Click the Select Tests tab and check the tests you want to run. Check the parent node or group to 
check all the available tests within the group.
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High-Speed Transmitter (HS-TX) Electrical Tests 4

Figure 7 Selecting High-Speed Transmitter Electrical Tests

5 Follow the MIPI C-PHY Compliance Test Application’s task flow to set up the configuration 
options, run the tests, and view the tests results.
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Test 1.2.7 HS-TX Differential Voltages (VOD-AB, VOD-BC, VOD-CA)

Test Overview

The purpose of this test is to verify that the Differential Voltages (VOD-AB, VOD-BC, VOD-CA) of the HS 
Transmitter DUT are within the conformance limits of the MIPI C-PHY standard specification.

The single-ended output voltages are defined VA, VB and VC at the A, B and C pins, respectively. The 
differential output voltages VOD_AB, VOD_BC and VOD_CA are defined at the difference of the voltages:

VOD_AB = VA - VB

VOD_BC = VB - VC

VOD_CA = VC - VA
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High-Speed Transmitter (HS-TX) Electrical Tests 4

Test Availability

Table 1 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS-TX Differential Voltages (VOD-AB, VOD-BC, VOD-CA) test.

Table 1 Configuration Options for HS-TX Differential Vol tages Test

References

See Test 1.2.7 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

For Test ID 1700, 1710, 1720

1 Capture waveforms for VA, VB and VC.

2 Construct the differential data waveform using the following equations:

DiffData(A-B) = VA - VB

DiffData(B-C) = VB - VC

DiffData(C-A) = VC - VA

CTS 
Test ID

Test ID
Test Name

LP Escape ONLY HS Symbol Rate

Enabled Disabled
<=1.0 
Gsps

1.0 Gsps < x 
<=1.5 Gsps

>1.5 
Gsps

1.2.7

1700
HS-TX Differential Voltages 

(VOD-AB-Strong1) [Max]
×  — — —

1701
HS-TX Differential Voltages 

(VOD-AB-Weak1) [Min]
×  — — —

1702
HS-TX Differential Voltages 

(VOD-AB-Weak0) [Max]
×  — — —

1703
HS-TX Differential Voltages 

(VOD-AB-Strong0) [Min]
×  — — —

1710
HS-TX Differential Voltages 

(VOD-BC-Strong1) [Max]
×  — — —

1711
HS-TX Differential Voltages 

(VOD-BC-Weak1) [Min]
×  — — —

1712
HS-TX Differential Voltages 

(VOD-BC-Weak0) [Max]
×  — — —

1713
HS-TX Differential Voltages 

(VOD-BC-Strong0) [Min]
×  — — —

1720
HS-TX Differential Voltages 

(VOD-CA-Strong1) [Max]
×  — — —

1721
HS-TX Differential Voltages 

(VOD-CA-Weak1) [Min]
×  — — —

1722
HS-TX Differential Voltages 

(VOD-CA-Weak0) [Max]
×  — — —

1723
HS-TX Differential Voltages 

(VOD-CA-Strong0) [Min]
×  — — —
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3 Fold the required DiffData waveform to form a Data Eye.

4 Use the Histogram feature to measure the minimum and maximum values for the parameters 
Strong1, Weak1, Weak0 and Strong0 at a point, which is 20% of the UI width before the trigger 
point. Configure the Histogram window settings with the following options:

a VOD(Strong1, Weak1) Histogram Window [Top](V)

b VOD(Strong1, Weak1) Histogram Window [Bottom](V)

c VOD(Strong0, Weak0) Histogram Window [Top](V)

d VOD(Strong0, Weak0) Histogram Window [Bottom](V)

e VOD Histogram Window Width (UI)

5 Report the measured values of VOD for all parameters mentioned in the previous step.

6 Compare the measured values of VOD against the compliance test limits.

For Test ID 1701, 1702, 1703

1 Run the following test as a prerequisite:

a Test 1.2.7 HS-TX Differential Voltages (VOD-AB-Strong1)[Max] — (Test ID 1700).

Store the test results after measuring all the required values of VOD-AB for the test signal.

2 Report the measured values of VOD that you obtain from the prerequisite test.

3 Compare the measured values of VOD against the compliance test limits.

For Test ID 1711, 1712, 1713

1 Run the following test as a prerequisite:

a Test 1.2.7 HS-TX Differential Voltages (VOD-BC-Strong1)[Max] — (Test ID 1710).

Store the test results after measuring all the required values of VOD-BC for the test signal.

2 Report the measured values of VOD that you obtain from the prerequisite test.

3 Compare the measured values of VOD against the compliance test limits.

For Test ID 1721, 1722, 1723

1 Run the following test as a prerequisite:

a Test 1.2.7 HS-TX Differential Voltages (VOD-CA-Strong1)[Max] — (Test ID 1720).

Store the test results after measuring all the required values of VOD-CA for the test signal.

2 Report the measured values of VOD for that you obtain from the prerequisite test.

3 Compare the measured values of VOD against the compliance test limits.

Expected/Observable Results

The measured value of VOD for the test signal must be within the conformance limit as specified in 
the CTS Specification mentioned under the References section.
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Test 1.2.8 HS-TX Differential Voltage Mismatch (∆VOD)

Test Overview

The purpose of this test is to verify that the Differential Voltage Mismatch (∆VOD) of the HS 
Transmitter DUT is within the conformance limits of the MIPI C-PHY standard specification.

Test Availability

Table 2 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS-TX Differential Voltage Mismatch (∆VOD) test.

Table 2 Configuration Options for HS-TX Differential Vol tage Mismatch Test

References

See Test 1.2.8 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Run the following tests as a prerequisite:

a Test 1.2.7 HS-TX Differential Voltages (VOD-AB-Strong1)[Max] — (Test ID 1700).

Store the test results after measuring all the required values of VOD-AB for the test signal.

b Test 1.2.7 HS-TX Differential Voltages (VOD-BC-Strong1)[Max] — (Test ID 1710).

Store the test results after measuring all the required values of VOD-BC for the test signal.

c Test 1.2.7 HS-TX Differential Voltages (VOD-CA-Strong1)[Max] — (Test ID 1720).

Store the test results after measuring all the required values of VOD-CA for the test signal.

2 Derive VOD-MAX from the maximum values of the parameter Strong1[Max] of VOD measured for 
the AB, BC and CA pairs.

3 Derive VOD-MIN from the minimum values of the parameter Strong0[Min] of VOD measured for the 
AB, BC and CA pairs.

4 Calculate the Differential Voltage Mismatch using the equation:

∆VOD = |VOD-MAX| - |VOD-MIN|

5 Compare the measured values of ∆VOD against the compliance test limits.

Expected/Observable Results

The measured value of ∆VOD for the test signal must be within the conformance limit as specified in 
the CTS Specification mentioned under the References section.

CTS 
Test ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled <=1.0 Gsps
1.0 Gsps < x 
<=1.5 Gsps

>1.5 Gsps

1.2.8 1800
HS-TX Differential Voltage 

Mismatch (∆VOD)
×  — — —
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Test 1.2.9 HS-TX Single-Ended Output High Voltages (VOHHS(VA), VOHHS(VB), VOHHS(VC))

Test Overview

The purpose of this test is to verify that the Single-Ended Output High Voltages (VOHHS(VA), 
VOHHS(VB) and VOHHS(VC)) of the HS Transmitter DUT are less than the maximum conformance limit 
values of the MIPI C-PHY standard specification.

Test Availability

Table 3 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS-TX Single-Ended Output High Voltages (VOHHS(VA), VOHHS(VB) and 
VOHHS(VC)) test.

Table 3 Configuration Options for HS-TX Single-Ended Output High Vol tages Test

References

See Test 1.2.9 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Capture waveforms for VA, VB and VC.

2 Calculate the UI width from the input HS Symbol Rate.

3 Fold the required single-ended data signal (VA, VB or VC) to form a Data Eye.

4 Enable the Histogram feature on the Oscilloscope.

5 Place the Histogram window on the upper level of the 3-level single-ended eye diagram such 
that the location of the window is at 20% of the UI width before the trigger point. Configure the 
Histogram window settings with the following options:

a VOHHS Histogram Window [Top](V)

b VOHHS Histogram Window [Bottom](V)

c VOHHS Histogram Window Width (UI)

6 Measure the mean value of the Histogram and use this value as the final VOHHS measurement 
result.

7 Compare the measured values of VOHHS against the compliance test limits.

Expected/Observable Results

The measured value of VOHHS for the test signal must be within the conformance limit values as 
specified in the CTS Specification mentioned under the References section.

CTS 
Test ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled <=1.0 Gsps
1.0 Gsps < x 
<=1.5 Gsps

>1.5 Gsps

1.2.9

1900
HS-TX Single-Ended Output 
High Voltages (VOHHS(VA))

×  — — —

1901
HS-TX Single-Ended Output 
High Voltages (VOHHS(VB))

×  — — —

1902
HS-TX Single-Ended Output 
High Voltages (VOHHS(VC))

×  — — —
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Test 1.2.10 HS-TX Static Common-Point Voltages (VCPTX)

Test Overview

The purpose of this test is to verify that the Static Common-Point Voltages (VCPTX) of the HS 
Transmitter DUT are within the conformance limits of the MIPI C-PHY standard specification. 
Figure 8 shows the static VCPTX distortion on the single-ended high-speed signals.

Figure 8 Static VCPTX distortion on the single-ended high-speed signals

The common-point voltage VCPTX is defined as the arithmetic mean value of the voltages at the A, B 
and C pins:

VCPTX = (VA + VB + VC) / 3

Test Availability

Table 4 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS-TX Static Common-Point Voltages (VCPTX) test.

Table 4 Configuration Options for HS-TX Static Common-Point Vol tages Test 

References

See Test 1.2.10 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

CTS 
Test ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled <=1.0 Gsps
1.0 Gsps < x 
<=1.5 Gsps

>1.5 Gsps

1.2.10

2000
HS-TX Static Common-Point 

Voltages (VCPTX_HS_+X)
×  — — —

2001
HS-TX Static Common-Point 

Voltages (VCPTX_HS_-X)
×  — — —

2002
HS-TX Static Common-Point 

Voltages (VCPTX_HS_+Y)
×  — — —

2003
HS-TX Static Common-Point 

Voltages (VCPTX_HS_-Y)
×  — — —

2004
HS-TX Static Common-Point 

Voltages (VCPTX_HS_+Z)
×  — — —

2005
HS-TX Static Common-Point 

Voltages (VCPTX_HS_-Z)
×  — — —
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Test Procedure

For Test ID 2000

1 Capture waveforms for VA, VB and VC.

2 Construct the differential data waveform using the following equations:

DiffData(A-B) = VA - VB

DiffData(B-C) = VB - VC

DiffData(C-A) = VC - VA

3 Use the generated differential waveforms to decode the wire states of only the HS data by 
sampling at the center of the UI for each wire state.

4 Generate the common-point voltage VCPTX signal using the equation:

VCPTX = (VA + VB + VC) / 3

5 Group the values of VCPTX for similar HS wire states. For example, all values of VCPTX that are 
sampled at the center of each of the UI measurements for the HS wire state +X are grouped 
together. Apply the same procedure for HS wire states -X, +Y, -Y, +Z and -Z.

6 Derive the maximum, minimum and mean values of VCPTX for each of the HS wire state groups.

7 Record the mean value of VCPTX as the final test result.

8 Compare the measured mean values of VCPTX against the compliance test limits.

For Test ID 2001, 2002, 2003, 2004, 2005

1 Run the following test as a prerequisite:

a Test 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_+X) — (Test ID 2000).

Store the test results after measuring the actual values of VCPTX for the test signal.

2 Report the measured values of VCPTX for that you obtain from the prerequisite test.

3 Compare the measured values of VCPTX against the compliance test limits.

Expected/Observable Results

The measured value of VCPTX for the test signal must be within the conformance limit values as 
specified in the CTS Specification mentioned under the References section.
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Test 1.2.11 HS-TX Static Common-Point Voltage Mismatch (∆VCPTX(HS))

Test Overview

The purpose of this test is to verify that the Static Common-Point Voltage Mismatch (∆VCPTX(HS)) of 
the HS Transmitter DUT is less than the maximum conformance limit values of the MIPI C-PHY 
standard specification.

Test Availability

Table 5 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS-TX Static Common-Point Voltage Mismatch (∆VCPTX(HS)) test.

Table 5 Configuration Options for HS-TX Static Common-Point Vol tage Mismatch Test

References

See Test 1.2.11 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Run the following tests as a prerequisite:

a Test 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_+X) — (Test ID 2000).

Store the test results after measuring the actual values of VCPTX for the test signal.

2 Calculate the VMAXCP, VMINCP and ∆VCPTX(HS) using the equations:

VMAXCP = max (VCPTX_HS_+X, VCPTX_HS_-X, VCPTX_HS_+Y, VCPTX_HS_-Y, VCPTX_HS_+Z, VCPTX_HS_-Z)

VMINCP = min (VCPTX_HS_+X, VCPTX_HS_-X, VCPTX_HS_+Y, VCPTX_HS_-Y, VCPTX_HS_+Z, VCPTX_HS_-Z)

∆VCPTX(HS) = (VMAXCP - VMINCP) / 2

3 Compare the measured values of ∆VCPTX(HS) against the compliance test limits.

Expected/Observable Results

The measured value of ∆VCPTX(HS) for the test signal must be within the conformance limit values as 
specified in the CTS Specification mentioned under the References section.

CTS 
Test ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled <=1.0 Gsps
1.0 Gsps < x 
<=1.5 Gsps

>1.5 Gsps

1.2.11 2100
HS-TX Static Common-Point 

Voltage Mismatch 
(∆VCPTX(HS))

×  — — —
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Test 1.2.12 HS-TX Dynamic Common-Point Variations Between 50-450MHz (∆VCPTX(LF))

Test Overview

The purpose of this test is to verify that the AC Common-Point Signal Level Variations Between 50 
and 450MHz (∆VCPTX(LF)) of the HS Transmitter DUT are less than the maximum allowable 
conformance limit values of the MIPI C-PHY standard specification. Figure 9 shows the dynamic 
VCPTX distortion on the single-ended high-speed signals.

Figure 9 Dynamic VCPTX distortion on the single-ended high-speed signals

Test Availability

Table 6 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS-TX Dynamic Common-Point Variations Between 50-450MHz (∆VCPTX(LF)) 
test.

Table 6 Configuration Options for HS-TX Dynamic Common-Point Variations Between 50 and 450MHz Test

References

See Test 1.2.12 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Capture waveforms for VA, VB and VC.

2 Generate the common-point voltage VCPTX signal using the equation:

VCPTX = (VA + VB + VC) / 3

3 Apply a band-pass filter with 3dB bandwidth frequency of 50MHz and 450MHz to the 
common-point waveform.

4 Measure the minimum and maximum values of voltage for the filtered waveform.

5 Record the maximum value of voltage as ∆VCPTX(LF).

CTS Test 
ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled
<=1.0 
Gsps

1.0 Gsps < 
x <=1.5 

Gsps
>1.5 Gsps

1.2.12 2200

HS-TX Dynamic 
Common-Point Variations 

Between 50-450MHz 
(∆VCPTX(LF))

×  — — —
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6 Compare the measured value of ∆VCPTX(LF) against the compliance test limits.

Expected/Observable Results

The measured value of ∆VCPTX(LF) for the test signal must be within the conformance limit values as 
specified in the CTS Specification mentioned under the References section.
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Test 1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (∆VCPTX(HF))

Test Overview

The purpose of this test is to verify that the AC Common-Point Signal Level Variations Above 450MHz 
(∆VCPTX(HF)) of the HS Transmitter DUT are less than the maximum allowable conformance limit 
values of the MIPI C-PHY standard specification. Figure 10 shows the dynamic VCPTX distortion on 
the single-ended high-speed signals.

Figure 10 Dynamic VCPTX distortion on the single-ended high-speed signals

Test Availability

Table 7 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS-TX Dynamic Common-Point Variations Above 450MHz (∆VCPTX(HF)) test.

Table 7 Configuration Options for HS-TX Dynamic Common-Point Variations Above 450MHz Test

References

See Test 1.2.13 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Capture waveforms for VA, VB and VC.

2 Generate the common-point voltage VCPTX signal using the equation:

VCPTX = (VA + VB + VC) / 3

3 Apply a band-pass filter with 3dB bandwidth frequency of 450MHz to the common-point 
waveform.

4 Measure the RMS value of the voltage for the filtered waveform.

5 Compare the measured value of ∆VCPTX(HF) against the compliance test limits.

CTS 
Test ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled <=1.0 Gsps
1.0 Gsps < x 
<=1.5 Gsps

>1.5 Gsps

1.2.13 2300
HS-TX Dynamic 

Common-Point Variations 
Above 450MHz (∆VCPTX(HF))

×  — — —
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Expected/Observable Results

The measured value of ∆VCPTX(HF) for the test signal must be within the conformance limit values as 
specified in the CTS Specification mentioned under the References section.
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Test 1.2.14 HS-TX Rise Time (tR)

Test Overview

The purpose of this test is to verify that the Rise Time (tR) of the HS Transmitter DUT is within the 
conformance limit value of the MIPI C-PHY standard specification.

Test Availability

Table 8 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS-TX Rise Time (tR) test.

Table 8 Configuration Options for HS-TX Rise Time Test

References

See Test 1.2.14 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Run the following tests as a prerequisite:

a Test 1.2.19 HS Clock Instantaneous UI (UIINST_Max) — (Test ID 2900).

Store the test results after measuring the minimum, maximum and average Unit Interval of the 
differential waveform.

2 Use the waveforms for VA and VB captured in the prerequisite test.

3 Construct the differential data waveform using the equation:

DiffData(A-B) = VA - VB

4 Identify and extract all Strong zero to weak one transitions within the differential data waveform. 
To configure the threshold levels, which in turn, is used to identify all the states; use the following 
options:

a Strong1 Threshold (V)

b Weak1 Threshold (V)

c Weak0 Threshold (V)

d Strong0 Threshold (V)

5 Measure values of Rise Time for all the identified transitions between the -58mV and +58mV 
levels.

6 Calculate the mean Rise Time value from the values obtained in the previous step. Use the value 
of the mean Rise Time tR(Mean) for the final test result.

7 Compare the measured value of tR(Mean) against the compliance test limits.

CTS 
Test ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled <=1.0 Gsps
1.0 Gsps < x 
<=1.5 Gsps

>1.5 Gsps

1.2.14

2400
HS-TX Rise Time (tR) 
[1.5 Gsps and below]

×    ×

2401
HS-TX Rise Time (tR)

[Above 1.5 Gsps]
×  × × 
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Expected/Observable Results

The measured value of tR for the test signal must be within the conformance limit values as specified 
in the CTS Specification mentioned under the References section.
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Test 1.2.15 HS-TX Fall Time (tF)

Test Overview

The purpose of this test is to verify that the Fall Time (tF) of the HS Transmitter DUT is within the 
conformance limit value of the MIPI C-PHY standard specification.

Test Availability

Table 9 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS-TX Rise Time (tR) test.

Table 9 Configuration Options for HS-TX Fall Time Test

References

See Test 1.2.15 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Run the following tests as a prerequisite:

a Test 1.2.19 HS Clock Instantaneous UI (UIINST_Max) — (Test ID 2900).

Store the test results after measuring the minimum, maximum and average Unit Interval of the 
differential waveform.

2 Use the waveforms for VA and VB captured in the prerequisite test.

3 Construct the differential data waveform using the equation:

DiffData(A-B) = VA - VB

4 Identify and extract all strong one to weak zero transitions within the differential data waveform. 
To configure the threshold levels, which in turn, is used to identify all the states; use the following 
options:

a Strong1 Threshold (V)

b Weak1 Threshold (V)

c Weak0 Threshold (V)

d Strong0 Threshold (V)

5 Measure values of Fall Time for all the identified transitions between the -58mV and +58mV 
levels.

6 Calculate the mean Fall Time value from the values obtained in the previous step. Use the value 
of the mean Fall Time tF(Mean) for the final test result.

7 Compare the measured value of tF(Mean) against the compliance test limits.

CTS 
Test ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled <=1.0 Gsps
1.0 Gsps < x 
<=1.5 Gsps

>1.5 Gsps

1.2.15

2500
HS-TX Fall Time (tF)

[1.5 Gsps and below]
×    ×

2501
HS-TX Fall Time (tF)

[Above 1.5 Gsps]
×  × × 
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Expected/Observable Results

The measured value of tF for the test signal must be within the conformance limit values as specified 
in the CTS Specification mentioned under the References section.
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Test 1.2.17 30%-85% Post-EoT Rise Time (TREOT)

Test Overview

The purpose of this test is to verify that the 30%-85% Post EoT Rise Time (TREOT) of the LP 
Transmitter DUT is within the conformance limits of the MIPI C-PHY standard specification.

Figure 11 TREOT Rise Time

Test Availability

Table 10 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the 30%-85% Post-EoT Rise Time (TREOT) test.

Table 10 Configuration Options for 30%-85% Post-EoT Rise Time Test

References

See Test 1.2.17 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Position the trigger point at the center of the screen.

2 Trigger on the rising edge of VA in the LP-111 state that occurs immediately after an HS Burst 
sequence.

3 Construct a differential data waveform using the equation:

DiffData(C-A) = VC - VA

4 Find the last transition edge of the differential waveform, DiffData(C-A) that crosses +/-48mV. 
Mark this time as T1.

5 Find the time after T1, when the rising edge of VA crosses VIH(min) = 740mV. Mark this time as T2. 
Note that T2 must be greater than T1.

CTS 
Test ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled <=1.0 Gsps
1.0 Gsps < x 
<=1.5 Gsps

>1.5 Gsps

1.2.17 2700
30%-85% Post EoT Rise 

Time (TREOT)
×  — — —
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6 Calculate TREOT using the equation:

TREOT = T2 - T1

7 Compare the measured value of TREOT against the compliance test limits.

Expected/Observable Results

The measured value of TREOT for the test signal must be within the conformance limit values as 
specified in the CTS Specification mentioned under the References section.
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Test 1.2.19 HS Clock Instantaneous UI (UIINST)

Test Overview

The purpose of this test is to verify that the value of the Instantaneous Unit Interval (UIINST) of the HS 
Transmitter DUT is within the conformance limit value of the MIPI C-PHY standard specification. 
Figure 12 shows the Instantaneous Unit Intervals on the High-Speed signal.

Figure 12 Instantaneous Unit Intervals on High-Speed signal

Test Availability

Table 11 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS Clock Instantaneous UI (UIINST) test.

Table 11 Configuration Options for HS Clock Instantaneous UI Test

References

See Test 1.2.19 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Capture waveforms for VA, VB and VC.

2 Construct the differential data waveform using the equation:

DiffData(A-B) = VA - VB

DiffData(B-C) = VB - VC

DiffData(C-A) = VC - VA

3 Measure the minimum, maximum and average values of Unit Interval for the differential 
waveforms based on the zero crossings between each UI.

CTS 
Test ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled <=1.0 Gsps
1.0 Gsps < x 
<=1.5 Gsps

>1.5 Gsps

1.2.19 2900
HS Clock Instantaneous UI 

(UIINST_Max)
×  — — —
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4 Store the minimum, maximum and average values of the Unit Interval as UI_Min, UI_Max and 
UI_Mean respectively.

5 Apply a Butterworth Low Pass test filter with a -3dB cut-off frequency of 2.0MHz to the measured 
UI data.

6 Measure and store the minimum, maximum and average values of the filtered Unit Interval data 
as UIInst_Filt_Min, UIInst_Filt_Max and UIInst_Filt_Mean respectively.

7 Use the value of UI_Max as the final measurement result and compare this value against the 
compliance test limits.

Expected/Observable Results

The measured value of UIINST for the test signal must be within the conformance limit values as 
specified in the CTS Specification mentioned under the References section.
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Test 1.2.20 HS Clock Delta UI (∆UI)

Test Overview

The purpose of this test is to verify that the frequency stability of the DUT’s HS Clock during a single 
burst is within the conformance limit value of the MIPI C-PHY standard specification.

Test Availability

Table 12 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the HS Clock Delta UI (∆UI) test.

Table 12 Configuration Options for HS Clock Del ta Test

References

See Test 1.2.20 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Run the following test as a prerequisite:

a Test 1.2.19 HS Clock Instantaneous UI (UIINST_Max) — (Test ID 2900).

Store the test results after measuring the minimum, maximum and average values of the Low 
Pass filtered Unit Interval of the differential waveforms.

2 Calculate UI_Variant_Min and UI_Variant_Max using the equations:

UI_Variant_Min = [(UIInst_Filt_Min - UIInst_Filt_Mean) / UIInst_Filt_Mean] * 100%

UI_Variant_Max = [(UIInst_Filt_Max - UIInst_Filt_Mean) / UIInst_Filt_Mean] * 100%

3 Determine UI_Variant_Worst based on the values of UI_Variant_Min and UI_Variant_Max 
calculated in the previous step.

4 Use the value of UI_Variant_Worst as the final test result and compare the determined value of 
UI_Variant_Worst against the compliance test limits.

Expected/Observable Results

The measured UI variation for the test signal must be within the conformance limit values as 
specified in the CTS Specification mentioned under the References section.

CTS 
Test ID

Test ID Test Name LP Escape ONLY HS Symbol Rate

Enabled Disabled <=1.0 Gsps
1.0 Gsps < x 
<=1.5 Gsps

>1.5 Gsps

1.2.20

3000
HS Clock Delta UI (∆UI)

[1 Gsps and below]
×   × ×

3001
HS Clock Delta UI (∆UI) 

[Above 1 Gsps]
×  ×  
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This section provides the Methods of Implementation (MOIs) for electrical tests for low-power 
transmitters (LP-TX) using an Keysight Infiniium Oscilloscope, InfiniiMax probes, and the MIPI C-PHY 
Compliance Test Application.
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Test 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH)

Test Overview

The purpose of this test is to verify that the Thevenin Output High Level Voltage (VOH) of the DUT’s 
LP Transmitter is within the conformance limits of the MIPI C-PHY standard specification.

Test Availability

Table 13 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the LP-TX Thevenin Output High Level Voltage (VOH) test.

Table 13 Configuration Options for LP-TX Thevenin Output High Level Vol tage Test 

References

See Test 1.1.1 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

For Test ID 100 (Data LP EscapeMode [Enabled])

1 Trigger on LP Data EscapeMode entry pattern of the data signal. If the LP EscapeMode is 
unavailable, the trigger is unable to capture any valid signal required for data processing.

2 Locate and use the Mark-1 state pattern to determine the end of the EscapeMode sequence.

3 Apply a 400MHz, 4th-order Butterworth Low Pass test filter to the EscapeMode sequence 
waveform data of the acquired VA.

4 Use the Histogram methodology to measure VOH of the filtered test waveform data. The vertical 
Histogram window must start at the point that indicates 50% of the absolute peak-to-peak VA 
signal amplitude.

5 Calculate the mode of the Histogram in the previous step and record this value as VOH for VA.

6 Repeat steps 3 - 5 for VB and VC.

7 Report the measurement results as:

Value of VOH for VA

Value of VOH for VB

Value of VOH for VC

8 Compare the measured “worst” value of VOH against the compliance test limits.

CTS 
Test ID

Test 
ID

Test Name
HS Burst Data - 
LPEscapeMode

LP Escape ONLY Informative Tests

Enabled Disabled Enabled Disabled Enabled Disabled

1.1.1

100
LP-TX Thevenin Output 

High Level Voltage (VOH) 
ESCAPEMODE

 × — — — —

101
LP-TX Thevenin Output 

High Level Voltage (VOH)
×  ×   ×
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For Test ID 101 (Data LP EscapeMode [Disabled], Informative Test [Enabled])

1 Trigger on the LP rising edge signal for VA. The Oscilloscope triggers according to the 
configuration of the “LP Observation” attribute. By default, ten rising edges are acquired.

2 Apply a 400MHz, 4th-order Butterworth Low Pass test filter to each acquired LP rising edge 
waveform data.

3 Use the Histogram methodology to measure VOH of the accumulated filtered test waveform data. 
The vertical Histogram window must start at the point that indicates 50% of the absolute 
peak-to-peak VA signal amplitude.

4 Calculate the mode of the Histogram in the previous step and record this value as VOH for VA.

5 Repeat steps 1 - 4 for VB and VC.

6 Report the measurement results as:

Value of VOH for VA

Value of VOH for VB

Value of VOH for VC

7 Compare the measured “worst” value of VOH against the compliance test limits.

Expected/Observable Results

The measured “worst” value of VOH for the test signal must be within the conformance limit as 
specified in the CTS Specification mentioned under the References section.
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Test 1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)

Test Overview

The purpose of this test is to verify that the Thevenin Output Low Level Voltage (VOL) of the DUT’s LP 
Transmitter is within the conformance limits of the MIPI C-PHY standard specification.

Test Availability

Table 14 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the LP-TX Thevenin Output Low Level Voltage (VOL) test.

Table 14 Configuration Options for LP-TX Thevenin Output Low Level Vol tage Test 

References

See Test 1.1.2 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

For Test ID 200 (Data LP EscapeMode [Enabled])

1 Run the following test as a prerequisite:

a Test 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH) ESCAPEMODE — (Test ID 100).

Store the test results after measuring the VOH values for the Low Power signals.

2 Use the entire LP EscapeMode sequence captured in the prerequisite test.

3 Apply a 400MHz, 4th-order Butterworth Low Pass test filter to the EscapeMode sequence 
waveform data of the acquired VA.

4 Use the Histogram methodology to measure VOL of the filtered test waveform data. The vertical 
Histogram window must start at the point that indicates 50% of the absolute peak-to-peak VA 
signal amplitude.

5 Calculate the mode of the Histogram in the previous step and record this value as VOL for VA.

6 Repeat steps 3 - 5 for VB and VC.

7 Report the measurement results as:

Value of VOL for VA

Value of VOL for VB

Value of VOL for VC

8 Compare the measured “worst” value of VOL against the compliance test limits.

CTS 
Test ID

Test 
ID

Test Name
HS Burst Data - 
LPEscapeMode

LP Escape ONLY Informative Tests

Enabled Disabled Enabled Disabled Enabled Disabled

1.1.2

200
LP-TX Thevenin Output 
Low Level Voltage (VOL) 

ESCAPEMODE
 × — — — —

201
LP-TX Thevenin Output 
Low Level Voltage (VOL)

×  ×   ×
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For Test ID 201 (Data LP EscapeMode [Disabled], Informative Test [Enabled])

1 Trigger on the LP falling edge signal for VA. The Oscilloscope triggers according to the 
configuration of the “LP Observation” attribute. By default, ten falling edges are acquired.

2 Apply a 400MHz, 4th-order Butterworth Low Pass test filter to each acquired LP falling edge 
waveform data.

3 Use the Histogram methodology to measure VOL of the accumulated filtered test waveform data. 
The vertical Histogram window must start at the point that indicates 50% of the absolute 
peak-to-peak VA signal amplitude.

4 Calculate the mode of the Histogram in the previous step and record this value as VOL for VA.

5 Repeat steps 1 - 4 for VB and VC.

6 Report the measurement results as:

Value of VOL for VA

Value of VOL for VB

Value of VOL for VC

7 Compare the measured “worst” value of VOL against the compliance test limits.

Expected/Observable Results

The measured “worst” value of VOL for the test signal must be within the conformance limit as 
specified in the CTS Specification mentioned under the References section.
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Test 1.1.3 LP-TX 15% - 85% Rise Time (TRLP)

Test Overview

The purpose of this test is to verify that the 15% - 85% Rise Time (TRLP) of the DUT’s LP Transmitter 
is within the conformance limits of the MIPI C-PHY standard specification.

Test Availability

Table 15 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the LP-TX 15% - 85% Rise Time (TRLP) test.

Table 15 Configuration Options for LP-TX 15% - 85% Rise Time Test 

References

See Test 1.1.3 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Run the following tests as a prerequisite:

a Test 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH) ESCAPEMODE — (Test ID 100).

b Test 1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL) ESCAPEMODE — (Test ID 200).

Store the test results after measuring all values of VOH and VOL for the Low Power signals.

2 Use the entire LP EscapeMode sequence captured in the prerequisite tests.

3 Apply a 400MHz, 4th-order Butterworth Low Pass test filter to the EscapeMode sequence 
waveform data of the mentioned VA; prior to measuring the actual Rise Time.

4 All rising edges in the filtered EscapeMode Sequence waveform data of the filtered VA are 
processed to measure the corresponding Rise Time.

5 Using the values of VOH and VOL as reference from the prerequisite tests, measure the 15% - 85% 
Rise Time for each rising edge of the VA waveform.

6 Record the average Rise Time for VA.

7 Repeat steps 3 - 6 for VB and VC.

8 Report the measurement results as:

Average value of TRLP for VA

Average value of TRLP for VB

Average value of TRLP for VC

9 Compare the measured “worst” value of TRLP against the compliance test limits.

CTS 
Test ID

Test 
ID

Test Name
HS Burst Data - 
LPEscapeMode

LP Escape ONLY Informative Tests

Enabled Disabled Enabled Disabled Enabled Disabled

1.1.3 300
LP-TX 15% - 85% 
Rise Time (TRLP) 
ESCAPEMODE

 × — — — —
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Expected/Observable Results

The measured “worst” value of TRLP for the test signal must be within the conformance limit as 
specified in the CTS Specification mentioned under the References section.
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Test 1.1.4 LP-TX 15% - 85% Fall Time (TFLP)

Test Overview

The purpose of this test is to verify that the 15% - 85% Fall Time (TFLP) of the DUT’s LP Transmitter is 
within the conformance limits of the MIPI C-PHY standard specification.

Test Availability

Table 16 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the LP-TX 15% - 85% Fall Time (TFLP) test.

Table 16 Configuration Options for LP-TX 15% - 85% Fall Time Test 

References

See Test 1.1.4 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

For Test ID 400 (Data LP EscapeMode [Enabled])

1 Run the following tests as a prerequisite:

a Test 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH) ESCAPEMODE — (Test ID 100).

b Test 1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL) ESCAPEMODE — (Test ID 200).

Store the test results after measuring all values of VOH and VOL for the Low Power signals.

2 Use the entire LP EscapeMode sequence captured in the prerequisite tests.

3 Apply a 400MHz, 4th-order Butterworth Low Pass test filter to the EscapeMode sequence 
waveform data of the mentioned VA; prior to measuring the actual Fall Time.

4 All falling edges in the filtered EscapeMode Sequence waveform data of the filtered VA are 
processed to measure the corresponding Fall Time.

5 Using the values of VOH and VOL as reference from the prerequisite tests, measure the 15% - 85% 
Fall Time for each falling edge of the VA waveform.

6 Record the average Fall Time for VA.

7 Repeat steps 3 - 6 for VB and VC.

8 Report the measurement results as:

Average value of TFLP for VA

Average value of TFLP for VB

Average value of TFLP for VC

9 Compare the measured “worst” value of TFLP against the compliance test limits.

CTS 
Test ID

Test 
ID

Test Name
HS Burst Data - 
LPEscapeMode

LP Escape ONLY Informative Tests

Enabled Disabled Enabled Disabled Enabled Disabled

1.1.4

400
LP-TX 15% - 85% Fall 

Time (TFLP) ESCAPEMODE 
 × — — — —

401
LP-TX 15% - 85% Fall 

Time (TFLP)
×  ×   ×
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For Test ID 401 (Data LP EscapeMode [Disabled], Informative Test [Enabled])

1 Run the following tests as a prerequisite:

a Test 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH) — (Test ID 101).

b Test 1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL) — (Test ID 201).

Store the test results after measuring all values of VOH and VOL for the Low Power signals.

2 Use all of the LP falling edges captured in the prerequisite tests.

3 Apply a 400MHz, 4th-order Butterworth Low Pass test filter to each captured LP falling edge 
waveform data.

4 Using the values of VOH and VOL as reference from the prerequisite tests, measure the 15% - 85% 
Fall Time for each filtered falling edge of the VA waveform.

5 Record the average Fall Time for VA.

6 Repeat steps 3 - 5 for VB and VC.

7 Report the measurement results as:

Average value of TFLP for VA

Average value of TFLP for VB

Average value of TFLP for VC

8 Compare the measured “worst” value of TFLP against the compliance test limits.

Expected/Observable Results

The measured “worst” value of TFLP for the test signal must be within the conformance limit as 
specified in the CTS Specification mentioned under the References section.
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Test 1.1.5 LP-TX Slew Rate vs. CLOAD

Test Overview

The purpose of this test is to verify that the Slew Rate of the DUT’s LP Transmitter is within the 
conformance limits of the MIPI C-PHY standard specification, for specific capacitive loading 
conditions.

Test Availability

Table 17 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the LP-TX Slew Rate vs. CLOAD test.

Table 17 Configuration Options for LP-TX Slew Rate vs. CLOAD Test

References

See Test 1.1.5 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Run the following tests as a prerequisite:

a Test 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH) ESCAPEMODE — (Test ID 100).

b Test 1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL) ESCAPEMODE — (Test ID 200).

Store the test results after measuring all values of VOH and VOL for the Low Power signals.

2 Use the entire LP EscapeMode sequence captured in the prerequisite tests.

3 Apply a 400MHz, 4th-order Butterworth Low Pass test filter to the EscapeMode sequence 
waveform data of the mentioned VA; prior to measuring the actual Slew Rate.

4 Measure Slew Rate on the EscapeMode sequence waveform data of the filtered VA for the VA 
waveform.

5 Repeat steps 3 and 4 for VB and VC.

6 Store the maximum, minimum and margin values of Slew Rate.

7 Report the measurement results.

8 Compare the measured “worst” value of Slew Rate against the compliance test limits.

CTS 
Test ID

Test 
ID

Test Name
HS Burst Data - 
LPEscapeMode

LP Escape ONLY Informative Tests

Enabled Disabled Enabled Disabled Enabled Disabled

1.1.5

500
LP-TX Slew Rate vs. 

CLOAD (RiseEdgeMax)
 × — — — —

501
LP-TX Slew Rate vs. 
CLOAD (RiseEdgeMin)

 × — — — —

502
LP-TX Slew Rate vs. 

CLOAD (RiseEdgeMargin)
 × — — — —

503
LP-TX Slew Rate vs. 
CLOAD (FallEdgeMax)

 × — — — —

504
LP-TX Slew Rate vs. 
CLOAD (FallEdgeMin)

 × — — — —
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Expected/Observable Results

The measured “worst” value of Slew Rate for the test signal must be within the conformance limit as 
specified in the CTS Specification mentioned under the References section.
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Test 1.1.6 LP-TX Pulse Width of Exclusive-OR Clock (TLP-PULSE-TX)

Test Overview

The purpose of this test is to verify that the Pulse Width of the XOR Clock (TLP-PULSE-TX) of the DUT’s 
LP Transmitter is within the conformance limits of the MIPI C-PHY standard specification. Figure 13 
shows the generation of LP XOR Clock from VA and VC.

Figure 13 Generation of LP XOR Clock from VA and VC.

Test Availability

Table 18 shows the the configuration options on the MIPI C-PHY Compliance Test Application that 
affect the availability of the LP-TX Pulse Width of Exclusive-OR Clock (TLP-PULSE-TX) test.

Table 18 Configuration Options for LP-TX Pulse Wid th of Exclusive-OR Clock Test

References

See Test 1.1.6 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

CTS 
Test ID

Test 
ID

Test Name
HS Burst Data - 
LPEscapeMode

LP Escape ONLY Informative Tests

Enabled Disabled Enabled Disabled Enabled Disabled

1.1.6

600
LP-TX Pulse Width of 
Exclusive-OR Clock 

(TLP-PULSE-TX)
 × — — — —

601
LP-TX Pulse Width of 
Exclusive-OR Clock 

(TLP-PULSE-TX) [Initial]
 × — — — —
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Test Procedure

1 Trigger on LP Data EscapeMode entry pattern of the data signal. If the LP EscapeMode is 
unavailable, the trigger is unable to capture any valid signal required for data processing.

2 Locate and use the Mark-1 state pattern to determine the end of the EscapeMode sequence.

3 Apply a 400MHz, 4th-order Butterworth Low Pass test filter to the EscapeMode sequence 
waveform data.

4 Find all crossing points at the minimum trip level (500mV) and at the maximum trip level (790mV) 
for VA and VC respectively.

5 Find the initial pulse width and the minimum pulse width of all the other signal pulses at the 
specified minimum trip level and maximum trip level. (Here, a pulse is defined as a positive pulse, 
that is, rising-to-falling-edge pulse).

6 Find the rising-to-rising and falling-to-falling periods of the XOR Clock at the specified minimum 
trip level and maximum trip level.

7 Record the “worst” case value for the pulse width found between the minimum trip level and 
maximum trip level as the value of TLP-PULSE-TX.

8 Compare the measured “minimum” value of TLP-PULSE-TX against the compliance test limits.

Expected/Observable Results

The measured “minimum” value of TLP-PULSE-TX for the test signal must be within the conformance 
limit as specified in the CTS Specification mentioned under the References section.
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Test 1.1.7 LP-TX Period of Exclusive-OR Clock (TLP-PER-TX)

Test Overview

The purpose of this test is to verify that the Period (TLP-PER-TX) of the XOR Clock of the DUT’s LP 
Transmitter is within the conformance limits of the MIPI C-PHY standard specification. Figure 14 
shows the generation of LP XOR Clock from VA and VC.

Figure 14 Generation of LP XOR Clock from VA and VC

Test Availability

Table 19 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the LP-TX Period of Exclusive-OR Clock (TLP-PER-TX) test.

Table 19 LP-TX Period of Exclusive-OR Clock Test Requirements for LP Signal ing 

References

See Test 1.1.7 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

CTS 
Test ID

Test 
ID

Test Name
HS Burst Data - 
LPEscapeMode

LP Escape ONLY Informative Tests

Enabled Disabled Enabled Disabled Enabled Disabled

1.1.7

700

LP-TX Period of 
Exclusive-OR Clock 

(TLP-PER-TX) 
[Rising-to-Rising]

 × — — — —

701

LP-TX Period of 
Exclusive-OR Clock 

(TLP-PER-TX) 
[Falling-to-Falling]

 × — — — —
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Test Procedure

1 Run the following test as a prerequisite:

a Test 1.1.6 LP-TX Pulse Width of Exclusive-OR Clock (TLP-PULSE-TX) — (Test ID 600).

The actual measurement algorithm for TLP-PER-TX is performed as part of this prerequisite test.

2 Measure the minimum value for all the rising-to-rising and falling-to-falling periods of the XOR 
clock at the minimum trip level (500mV) and the maximum trip level (790mV) as TLP-PER-TX.

3 Record the value of TLP-PER-TX as the final test result.

4 Compare the measured “minimum” value of TLP-PER-TX against the compliance test limits.

Expected/Observable Results

The measured value of TLP-PER-TX for the test signal must be within the conformance limit as 
specified in the CTS Specification mentioned under the References section.
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This section provides the Methods of Implementation (MOIs) for the timing tests for high-speed 
transmitters (HS-TX) using an Keysight Infiniium Oscilloscope, InfiniiMax probes, and the MIPI C-PHY 
Compliance Test Application.
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Test 1.2.1 TLPX Duration

Test Overview

The purpose of this test is to verify that the duration (TLPX) of the final LP-001 state immediately prior 
to the High Speed Transmission is greater than the minimum conformance limits of the MIPI C-PHY 
standard specification. Figure 15 shows the Data Lane TLPX Interval in a High-Speed Data 
Transmission.

Figure 15 Data Lane TLPX Interval in a High-Speed Data Transmission

Test Availability

Table 20 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the Duration (TLPX) test.

Table 20 Configuration Options for TLPX Duration Test

References

See Test 1.2.1 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Trigger on the falling edge of VA in the LP-001 state, which occurs immediately before an HS 
Burst sequence.

2 Mark the time when the falling edge of VA first crosses VIL(Max) = 550mV. Denote this time as T1.

3 Mark the time when the first falling edge of VC after T1, crosses VIL_Max = 550mV. Denote this 
time as T2. Note that T2 must be greater than T1.

4 Calculate TLPX using the equation:

TLPX = T2 - T1

5 Compare the calculated value of TLPX against the compliance test limits.

CTS Test ID Test ID Test Name LP Escape ONLY

Enabled Disabled

1.2.1 1100 TLPX Duration × 
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Expected/Observable Results

The calculated value of TLPX for the test signal must be within the conformance limit as specified in 
the CTS Specification mentioned under the References section.
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Test 1.2.2 T3-PREPARE Duration

Test Overview

The purpose of this test is to verify that the duration (T3-PREPARE) of the final LP-000 state 
immediately prior to the High Speed Transmission is within the conformance limits of the MIPI C-PHY 
standard specification. Figure 16 shows the T3-PREPARE Interval in a High-Speed Data Transmission.

Figure 16 T3-PREPARE Interval in a High-Speed Data Transmission

Test Availability

Table 21 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the Duration (T3-PREPARE) test.

Table 21 Configuration Options for T3-PREPARE Duration Test

References

See Test 1.2.2 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Run the following test as a prerequisite:

a Test 1.2.1 TLPX Duration — (Test ID 1100).

Store the test results after measuring the TLPX Duration of the test signal.

2 Use the waveforms VA, VB and Vc captured in the prerequisite test.

3 Construct the differential data waveform using the equation:

DiffData(A-B) = VA - VB

DiffData(B-C) = VB - VC

DiffData(C-A) = VC - VA

4 Use the measured value of T2 from the prerequisite test as the starting point for T3-PREPARE.

5 Find and mark the first transition edge of the differential waveform, which crosses +/-48mV. 
Denote it as T3. Note that T3 must be greater than T2.

CTS Test ID Test ID Test Name LP Escape ONLY

Enabled Disabled

1.2.2 1200 T3-PREPARE Duration × 
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6 Calculate T3-PREPARE using the equation:

T3-PREPARE = T3 - T2

7 Compare the calculated value of T3-PREPARE against the compliance test limits.

Expected/Observable Results

The calculated value of T3-PREPARE for the test signal must be within the conformance limit as 
specified in the CTS Specification mentioned under the References section.
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Test 1.2.18 THS-EXIT Value

Test Overview

The purpose of this test is to verify that the duration (THS-EXIT) the Data Lane Transmitter remains in 
the LP-111 (Stop) state after exiting HS mode is greater than minimum required value as per the 
conformance limits of the MIPI C-PHY standard specification. Figure 17 shows the THS-EXIT Interval in 
a High-Speed Data Transmission.

Figure 17 THS-EXIT Interval in a High-Speed Data Transmission

Test Availability

Table 22 shows the configuration options on the MIPI C-PHY Compliance Test Application that affect 
the availability of the THS-EXIT Value test.

Table 22 Configuration Options for THS-EXIT Value Test

References

See Test 1.2.18 of the C-PHY Physical Layer Conformance Test Suite v1.0r10 (23Mar2015).

Test Procedure

1 Position the trigger point at the center of the screen. Trigger on the rising edge of VA in the 
LP-111 state, which occurs immediately after an HS Burst sequence.

2 Construct the differential data waveform using the equation:

DiffData(C-A) = VC - VA

3 Find and mark the last transition edge of the differential waveform, DiffData(C-A), which crosses 
+/-70mV. Denote it as T4.

4 Find the time after T4 when the falling edge of VA crosses VIL(Max) = 550mV. Mark this time as T5. 
Note that T5 must be greater than T4.

5 Calculate THS-EXIT using the equation:

THS-EXIT = T5 - T4

6 Compare the calculated value of THS-EXIT against the compliance test limits.

CTS Test ID Test ID Test Name LP Escape ONLY

Enabled Disabled

1.2.18 2800 THS-EXIT Value × 
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Expected/Observable Results

The calculated value of THS-EXIT for the test signal must be within the conformance limit as specified 
in the CTS Specification mentioned under the References section.
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7 Calibrating the Infiniium 
Oscilloscope

Required Equipment for Oscilloscope Calibration  /  74
To Run the Self Calibration  /  75
Probe Calibration and De-skew  /  80

This section describes the Keysight Infiniium Oscilloscopes calibration procedures.
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Required Equipment for Oscilloscope Calibration

To calibrate the Infiniium oscilloscope in preparation for running the MIPI C-PHY automated tests, 
you need the following equipment:

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Precision 3.5 mm BNC to SMA male adapter, Keysight p/n 54855-67604, qty = 2 (provided with 
the Keysight Infiniium oscilloscope).

• Calibration cable (provided with the Keysight Infiniium oscilloscopes). Use a good quality 50 Ω 
BNC cable.
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To Run the Self Calibration

The self calibration uses signals generated in the Oscilloscope to calibrate Channel sensitivity, 
offsets, and trigger parameters. You should run the self calibration

• yearly or according to your periodic needs,

• when you replace the acquisition assembly or acquisition hybrids,

• when you replace the hard drive or any other assembly,

• when the oscilloscope’s operating temperature (after the 30 minute warm-up period) is more than 
±5 °C different from that of the last calibration.

Internal or Self Calibration

This will perform an internal diagnostic and calibration cycle for the oscilloscope. For the Keysight 
oscilloscope, this is referred to as Calibration. This Calibration will take about 20 minutes. Perform 
the following steps:

1 Set up the oscilloscope with the following steps:

a Connect the keyboard, mouse, and power cord to the rear of the oscilloscope.

b Plug in the power cord.

c Turn on the oscilloscope by pressing the power button located on the lower left of the front 
panel.

d Allow the oscilloscope to warm up at least 30 minutes prior to starting the calibration 
procedure in step 3 below.

2 Locate and prepare the accessories that will be required for the internal calibration:

a Locate the BNC shorting cap.

b Locate the calibration cable.

c Locate the two Keysight precision SMA/BNC adapters.

d Attach one SMA adapter to the other end of the calibration cable — hand tighten snugly.

e Attach another SMA adapter to the other end of the calibration cable — hand tighten snugly.

NOTE
Let the Oscilloscope warm up before adjusting. Warm up the Oscilloscope for 30 minutes before 
starting calibration procedure. Failure to allow warm up may result in inaccurate calibration.

NOTE
Calibration time: It takes approximately 1 hour to run the self calibration on the Oscilloscope, 
including the time required to change cables from Channel to Channel.
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3 From the Infiniium Oscilloscope’s main menu, click Util ities>Calibration....

Figure 18 Accessing Calibration dialog on the Oscilloscope

The Calibration dialog appears.
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4 To start the calibration process:

a Clear the Cal Memory Protect checkbox.

You cannot run self calibration if this box is checked. See Figure 19.

Figure 19 Clearing Cal Memory Protect and Starting Calibration

b Click Start to begin calibration.

c Follow the on-screen instructions.
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d During the calibration of any Oscilloscope Channel, if the oscilloscope prompts you to perform 
a Time Scale Calibration, select Standard Cal and Defaul t Time Scale in the Calibration Options 
dialog.

Figure 20 Selecting options from the Calibration Options dialog

The options under the Calibration Options dialog are:

• Standard Cal ibration—Oscilloscope does not perform time scale calibration and uses calibration 
factors from the previous time scale calibration and the reference signal is not required. The 
rest of the calibration procedure continues.

• Standard and Time Scale Cal—Oscilloscope performs time scale calibration. You must connect a 
reference signal to the Oscilloscope Channel, after ensuring that the reference signal meets 
the following specifications. Failure to meet these specifications result in an inaccurate 
calibration.
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• Standard Cal and Defaul t Time Scale—Oscilloscope uses the default time scale calibration factors 
and does not require the 10 MHz reference signal. The rest of the calibration procedure 
continues.

e Disconnect everything from all inputs and Aux Out.

f Connect the calibration cable from Aux Out to a specific Channel.

g Connect the calibration cable from Aux Out to each of the Channel inputs as requested.

h Connect the 50 Ω BNC cable from the Aux Out to the Aux Trig on the front panel of the 
Oscilloscope.

i A Passed/Failed indication is displayed for each calibration section. If any section fails, check 
the calibration cables and run the Oscilloscope Sel f Test... in the Util ities... menu. 

j After the calibration procedure is completed, click Close.

NOTE
These steps do not need to be performed every time a test is run. However, if 
the ambient temperature changes more than 5 degrees Celsius from the 
calibration temperature, this calibration should be performed again. The delta 
between the calibration temperature and the present operating temperature is 
shown in the Util ities>Calibration menu.
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Probe Calibration and De-skew

Along with calibrating the Infiniium Oscilloscope, it is a good practice to calibrate and de-skew the 
probes, before you start running the automated tests.

Required Equipment for Probe Calibration

Before performing the compliance tests, calibrate the probes. Calibration of the solder-in probe 
heads consists of a vertical calibration and a skew calibration. The vertical calibration should be 
performed before the skew calibration. Both calibrations should be performed for best probe 
measurement performance.

The calibration procedure requires the following parts.

• BNC (male) to SMA (male) adapter

• Deskew fixture

• 50 Ω SMA terminator

SMA Probe Head Attenuation/Offset Calibration

Perform the following steps

1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the connector closest to the 
yellow pincher.

2 Connect the 50 Ω SMA terminator to the connector farthest from the yellow pincher.

3 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium oscilloscope.

4 Connect the probe to an oscilloscope channel.

5 To minimize the wear and tear on the probe head, it should be placed on a support to relieve the 
strain on the probe head cables.

6 Push down the back side of the yellow pincher. Insert the probe head resistor lead underneath 
the center of the yellow pincher and over the center conductor of the deskew fixture. The 
negative probe head resistor lead or ground lead must be underneath the yellow pincher and 
over one of the outside copper conductors (ground) of the deskew fixture. Make sure that the 
probe head is approximately perpendicular to the deskew fixture.

7 Release the yellow pincher.
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Figure 21 Example of Solder-in Probe Head Calibration Connection
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8 To verify the connection, press the autoscale button on the front panel of the Infiniium 
Oscilloscope.

9 Set the volts per division to 100 mV/div.

10 Set the horizontal scale to 1.00 ns/div.

11 Set the horizontal position to approximately 3ns. A waveform similar to the one displayed in Figure 
22 must appear.

Figure 22 Example of a waveform when the probe connection is good
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If a waveform similar to that shown in Figure 23 appears, it indicates that there is a bad 
connection and you must check all your probe connections.

Figure 23 Example of a waveform when the probe connection is bad
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12 On the Infiniium Oscilloscope,

a Click Setup>Channel 1....

b The Channel dialog displays to set up Channel 1 of the Oscilloscope.
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c Click Probe.... The Probe Configuration dialog displays.

d In the Differential SMA block, click the Select Head... button.

e Select N5380A/B from the list.



7 Calibrating the Infiniium Oscilloscope

86 MIPI C-PHY Compliance Test Application Methods of Implementation

f In the Calibration Status area, click the Cal... button corresponding to Atten/Offset.

g The Probe Calibration dialog displays. Click Start Atten/Offset Cal....

h The Calibration wizard displays. Follow the on-screen instructions. At the end of the 
Atten/Offset Calibration, perform the Skew calibration for the SMA Probe Head.
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SMA Probe Head Skew Calibration

This procedure ensures that the timing skew errors between channels are minimized. After the 
Atten/Offset Calibration is done, perform the following steps for skew calibration:

1 On the Probe Cal ibration dialog, click Start Skew Cal....

2 The Calibration wizard displays. Follow the on-screen instructions.

Differential SMA Probe Head Atten/Offset Calibration

Perform the following steps

1 Ensure that a probe, attached to an SMA Probe Head is connected to Channel 1 of the 
Oscilloscope.

2 Install the 80 Ω resistors into the SMA Probe Head. These resistors are required only for probe 
calibration and de-skew.

3 Connect the De-skew fixture to AUX Out.

4 Clip the resistors on the De-Skew fixture.
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5 On the Infiniium Oscilloscope,

a Click Setup>Channel 1....

b The Channel dialog displays to set up Channel 1 of the Oscilloscope.
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c Click Probe.... The Probe Configuration dialog displays.

d In the Differential Socketed block, click the Select Head... button.

e Select E2678A/B from the list.
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f In the Calibration Status area, click the Cal... button corresponding to Atten/Offset.

g The Probe Calibration dialog displays. Click Start Atten/Offset Cal....

h The Calibration wizard displays. Follow the on-screen instructions. At the end of the 
Atten/Offset Calibration, perform the Skew calibration for the Differential SMA Probe Head.
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Differential SMA Probe Head Skew Calibration

This procedure ensures that the timing skew errors between channels are minimized. After the 
Atten/Offset Calibration is done, perform the following steps for skew calibration:

1 On the Probe Cal ibration dialog, click Start Skew Cal....

2 The Calibration wizard displays. Follow the on-screen instructions.

For more information on connecting probes to the Infiniium Oscilloscope, refer to the De-skew and 
Calibration manual. This manual comes together with the E2655A/B/C Probe De-skew and 
Performance Verification Kit.

NOTE
Each probe is calibrated to the Oscilloscope Channel to which it is 
connected. Do not switch probes between Channels or other Oscilloscopes, 
else it becomes necessary to calibrate them again. One of the best practices 
is to label the probes with the Channel number on which they are 
calibrated.
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8 InfiniiMax Probing

This section describes the recommended InfiniiMax Probes used with Keysight Infiniium 
Oscilloscopes.

 

Keysight recommends 116xA or 113xA probe amplifiers, which range from 3.5 GHz to 12 GHz.

Keysight also recommends the E2677A differential solder-in probe head. Other probe head options 
include N5381A InfiniiMax II 12 GHz differential solder-in probe head, N5425A InfiniiMax ZIF probe 
head and N5426A ZIF Tips.

Figure 24 1134A InfiniiMax Probe Amplifier

Figure 25 E2677A / N5381A Differential Solder-in Probe Head
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Used with 1168A or 1169A probe amplifier, the E2677A differential solder-in probe head provides 10 
GHz and 12 GHz bandwidth respectively.

Table 23 Probe Head Characteristics (with 1134A probe amplifier)

Probe Head Model 
Number

Differential Measurement
(BW, input C, input R)

Single-Ended Measurement
(BW, input C, input R)

Differential Solder-in E2677A 7 GHz, 0.27 pF, 50 kOhm 7 GHz, 0.44 pF, 25 kOhm
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